
 
  
Welcome to sPlan 7.0 
  
sPlan is an easy-to-handle and comfortable CAD-software, developed for electronic and electric circuit 
diagrams. Dragging and dropping components from the library to the diagram is as easy as it can be 
and components fit exactly to the grid. 
  
All components and drawing elements are free editable on your circuit diagram. You can build groups, 
move, rotate, cut, copy, paste, delete,... 
  
sPlan is equipped with lots of features like automatic component numbering and auto-generation of 
component lists. 
  
sPlan produces high-quality printouts, which can be previewed to adjust scale and position of the print. 
All changes will take effect in the preview immediately. 
  
The well-sorted library contains lots of parts, components and symbols. You can extend the library with 
your own components as you like.  
  
We have spent much time to create an easy-to-handle software. After a short settling-in period you will 
see how easy it can be to create perfect circuit diagrams. 
  
You can get more information and updates on our homepage www.abacom-online.de/uk 
New features of sPlan 7.0 
  
Here is a list of all essential new features compared with version 6.0: 
  
Parent-Child relations 
Components can have a Parent-Child relation. A "parent" knows all his "child's", and a "child" knows his 
"parent". This allows a child to get the identifier and the value of his parent. If the parent is changed, 
the child will change his identifier automatically. This is a big advantage, especially if you are using 
contactors and contacts or IC's with several gates. 
  
Dimension function 
The new dimension function let's you add dimensions for technical drawings. You can place dimensions 
for distances, radii, diameters or   angles. 
  
Banner printing 
This new function lets you print your drawing spread over several pages. So you can e.g. create a A2 
printout with a normal A4-printer. 
  
Mouse wheel support 
sPlan is now using the mouse wheel best possible to zoom and navigate your drawing. You won't use 
the "zoom-mode" or the scrollbars anymore. 
  
Virtual nodes 
These nodes are located in the middle of each line. Just drag them to a new position to create new 
nodes. This simplifies the editing of polylines. 
  
Linestyles for all elements 
There are several linestyles available for all elements, also for bezier curves, rectangles, circles, arcs 
and polygons. 
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Change properties of several elements 
You can now change the properties of several elements at one go. Just select the desired elements and 
you can assign all changes to all selected elements. 
  
Centered text 
A text can now get a centered alignment. Thus the text will always keep centered, even if the textlength 
is changing. 
  
Measure mode 
This new mode is to measure out your drawing exactly and comfortable. 
  
Scale function 
You can define a new scale (e.g. 1:10) and sPlan will consider this scale for all coordinates, dimension, 
rulers, etc. 
  
New Active-links functions 
Active links can be followed for- and also backwards within your project. Even external links e.g. to PDF
documents or websites are possible. 
  
Dot grid 
The optional dot grid of sPlan increases the clearness of your drawing. 
  
Sorting function for pages 
This new function is very helpful, especially for projects with a lot of pages.. 
  
New sPlan-Viewer 
The new free viewer-application for opening, viewing and printing sPlan files now supports also the 
active links within a project. Even a internet-update function is implemented. The viewer supports all 
files from version 4.0. Of course, this new viewer is also free available. 
Main screen 
  

 
  
Let's have a look at the sPlan software and its sections. On the top of the main window you find the 
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main menu and the toolbar. sPlan displays short hints, when you move the mouse to control elements 
like buttons and stay there for a moment. 
  
On the left side you can find the component library with a light blue colored background. You can drag 
components from the library and drop them to your diagram. To adjust the width of the library section, 
move the mouse cursor to the right border of the library. The cursor will show a split symbol. Hold down 
the left mouse button and adjust the width by moving the mouse. 
On the bottom of the library some buttons offer additional library functions. 
  
The vertical toolbar right from the library contains several tool buttons, to activate different editing and 
drawing modes. 
  
Diagrams are drawn on the light yellow area of the application. On the bottom of this drawing area you 
find a register that contains entries for each page that your project consists of. Simply click to one of 
these entries to show and activate one of the pages. 
  
A status bar on the bottom of the main window displays information about mouse position, line settings, 
etc. Here you can also define important parameters like snap grid on/off or the value of the angle grid. 
Page properties 
  
The first thing to do is to define the paper format that you want to use for your diagram. There are two 
possible ways to do this. You can select PAGE PROPERTIES... from the PAGE item of the main menu 
or you can click with the right mouse button to the PAGE REGISTER (at the bottom of the diagram) 
and select PAGE PROPERTIES... from the local context menu. 
  

 
  
A dialog will appear that allows you to enter the format, the orientation and the name for the current 
page. The extended descriptions will be displayed as a tooltip on the pages register in sPlan. 
  
You can call this dialog whenever you want to make changes to one of the page properties. 
  
Adjusting the grid 
  
When editing a diagram with sPlan, normally a grid will be active. The grid is very helpful to place 
elements and for connecting components with lines. The default value for the grid is 1mm. Generally 
this will be a good value, but you can change this value if necessary. The grid distance is saved for each 
individual project file and can be changed by selecting Options -> General settings... from the main 
menu and the select Grid in the left section. 
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You can also call the grid dialog, using the grid button from the toolbar. If you have to change grid 
values regularly for some reasons, you can click to the downward pointing arrow right from this tool 
button to select often-needed grid values. 
  

 
  
Grid distance: 
Here you can enter the grid distance in steps of 1/10 mm (10 = 1mm).  
  
Contrast: 
Here you can define the contrast of the displayed grid. You can even hide the grid here. 
  
Subdivisions: 
Herewith you can divide the grid once more. 
E.g. if it is set to "5", every 5th grid line will be displayed a little stronger. This feature is a big 
advantage, if you need to count the grids, etc. 
  
Lines / Dots 
This option defines if the grid will be displayed as lines or dots. 
  
Tip: 
If you want to have the grid capture deactivated temporary, hold down the CTRL key on your keyboard. 
The grid will be turned off, until you release the CTRL key. 
  
You may also turn off the grid capture completely, using the corresponding button in the status bar at 
the bottom of sPlan.  
  

 
  
In that case the grid is still visible, but the capture is turned of. 
Rubber band 
  
The rubber band function should help to keep the connections together while moving single components 
or other elements. If a connected component is moved while the rubber band function is enabled, the 
component takes all connected lines with it. 
  

 With this button in the statusbar of sPlan you can enable or disable the rubber band function. 
  
sPlan can only detect connected elements, if they are properly connected. If a line is overlapping a 
connection of a component, this connection will not detect as "connected". The rubber band function will 
also not work if 2 components are connected directly (this means without a line between). In this case 
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there exists no line, which the rubber band could take with. 
  
After you have moved a component with the rubber band function, is is in most cases necessary to 
adjust the connection line(s). If you select the line you can move the line nodes with the changer. You 
can even add or delete nodes of the line. Just click with the right mouse button on a changer and select 
add or delete. 
Snap to connections 
  
The snap-to-connections function is a very useful feature of sPlan. This function activates, in addition to 
the general grid snap, an automatic snap at all connection-points. A connection-point can be any line 
node or any start and end point of a circle or bezier curve. 
  

 With this button in the statusbar of sPlan you can enable or disable the snap-to-connections 
function. 
  
As soon as you get near a connection-point in a corresponding action, the connection-point will capture 
the mouse position. A red square will be displayed, to indicate that the mouse position is currently 
captured by a connection-point. This capturing helps you to connect your elements in a very accurate 
way. 
  
Select, move, turn and delete elements 
  
Selecting elements 
After you have drawn some elements, you may want to change their position, size, color, etc. To make 
any changes to an element, you have to select it at first. Therefore you have to activate the default edit 
mode and select the element with a single mouse click. Click exactly to the elements outline, if the 
element has no filled areas. 
  
Selected elements are always drawn in magenta colors, and they are surrounded with 8 little black 
squares, the sizer. 
  
To select more than one element you can draw a frame. All elements, that cross the frame will be 
selected. You can also hold the SHIFT key of your keyboard and click to a single element, to add this 
element to the selection. Click again to deselect a single element, while holding the SHIFT key. To 
deselect all elements click to an unused area of the diagram. 
  
Moving elements 
Select all elements you want to move. Click to the outline of one of the selected elements, hold the left 
mouse button, and move the elements to their new position. You can also use the arrow keys of the 
keyboard to move selected elements. 
  
Deleting elements 
Select all elements, you want to delete. Then select EDIT->DELETE from the main menu or press the 
delete button from the toolbar. You can also use the DEL-key from the keyboard, to delete all selected 
elements. 
  
  
Rotating, scaling and shearing 
Selected elements can be rotated, scaled or sheared in any way you like. You need only your mouse to 
control all these functions. Just use the sizer and changer. 
Sizer and Changer 
  
Sizer 
When selecting one or more elements, eight tiny black rectangles are displayed all around the selection 
- the so-called SIZER.  
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Use the sizer to scale the selected elements. Move the mouse to one of the sizer. The mouse cursor will 
change to show the direction of sizing. Click to the sizer and move the mouse while holding the left 
mouse button down. Release the mouse button when finished. 
  
If you click on a selected element again, the sizer rectangles will change into arrows. 
  

 
  
With these arrows you can rotate and shear the element. To rotate the element, just click on one of the 
4 round arrows in the edges. Keep the mouse button pressed, and move the mouse around the element 
to control the rotational angle. The rotation angle will be always snapped, as you defined the rotation 
angle snap in the status line of sPlan. 
  

 
  
If you press the CTRL-Key while rotating, you can disable the rotating angle snap temporary. 
  
  
Changer 
Some elements offer so-called CHANGER. The changer are small white rectangles on the outline of the 
element, which are used to move significant points of an element. 
  

 
  
With the changer, you can change the following elements: 
  
Lines, polygons: 
You can move any node of the line or polygon. You can click with the right mouse button on a changer 
to add a new node or to delete a node. 
  
Bezier curves: 
You can move the start, end and the control points of the bezier curve. 
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Circles: 
The changer defines the start and end point of the circle. You can use this to create circle segments. 
  
Rectangles: 
The changer adjusts the rounding of the 4 corners of the rectangle. 
  
Dimensions: 
The changer adjusts the position of the dimension line. 
Drawing functions 
  
sPlan offers all drawing elements you need to create high-quality and nice-looking circuit diagrams: 
       

l Rectangles, rounded rectangles  
l Circles, ellipses and circle segments  
l Polygons (closed areas with or without filling)  
l Special forms (regular polygons, stars, tables and sine curves)  
l Lines  
l Bezier curves  
l Dimensions  
l Connection points  
l Text labels  
l TextRect (for explanations, etc.)  
l Bitmaps (Logos, graphics, etc.)  

  
To draw one of these elements click on the corresponding button of the vertical toolbar right beside the 
library. 
  
To select and edit your elements, you should return to the default edit mode (arrow). You can easily 
return to the default edit mode, by pressing the right mouse button while the mouse cursor is 
somewhere on your diagram. 
  
If you press the right mouse button again (in default mode), a local popup menu opens and offers often 
needed functions. 
How to draw (rounded) rectangles 
  

 
  
  

 Select the RECTANGLE mode from the mode section. 
  
Click to the start position of the rectangle and hold the mouse button down. Move the mouse to the 
rectangles stop position (bottom right) and release the mouse button. The rectangle is now created, and 
you can go on with another one. 
  
You can press the SHIFT-key while you are drawing a rectangle to force an exact square. 
  
When you finished drawing rectangles, return to default edit mode (arrow), to change its size or 
properties. Use the changer to round the corners of the rectangle. 
  
The rectangle will always be created with the currently selected preferences. 
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With a doubleclick on the rectangle you can edit its properties like pen, brush, etc.  
How to draw circles, ellipses and circle segments 
  

 
  
  

 Select the CIRCLE mode from the mode section. 
  
Click to the start position of the rectangle and hold the mouse button down. Move the mouse to the end 
position (bottom right) and release the mouse button. The circle is now created, and you can go on with 
another one. 
  
You can press the SHIFT-key while you are drawing a circle to force an exact circle instead of an ellipse.
  
When you finished drawing circles, return to default edit mode (arrow), to change its size or properties. 
Use the changer to define the start and stop points of the circle. So you can create a circle segment. 
  
The circle will always be created with the currently selected preferences. 
  
With a doubleclick on the circle you can edit its properties like pen, brush, etc.  
How to draw polygons 
  

 
  
  

 Select the POLYGON mode from the mode section. 
  
The first click marks the start point of the polygon. Click again at another position to mark the next 
point, and so on. 
  
If you have finished the polygon press the right mouse button. The polygon will now be closed 
automatically. You can now start with another polygon. Press the right mouse button again, to return to 
the default edit mode.  
  
When you have finished drawing polygons, return to default edit mode (arrow), to change its size or 
properties. Use the changer to move the nodes of the polygon.  
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You can add new nodes to your polygon by using the virtual nodes. There is a virtual node (blue circle) 
in the middle of every line segment. If you click to a virtual node and move this node, the virtual node 
will become a real node. So you can add new nodes to your polygon. 
  
You can also delete a node. Just click with the right mousebutton on a node and select the desired 
option. 
  
The polygon will always be created with the currently selected preferences. 
With a doubleclick on the polygon you can edit its properties like pen, brush, etc.  
  
The line's angle is captured to a certain value, which is displayed in the status bar. 
  

 
  
Click on the display to select another value. To turn off the angle capture temporary hold down the 
CTRL-key of your keyboard. 
  
Tip:  
The polygons are only drawn with the current defined angle capture. You can disable this angle 
capturing by pressing the <SHIFT>-key while drawing your polygon. If you press the <CTRL>-key, you 
can also disable the grid capture. 
  
How to draw special forms 
  
The "special forms" are often needed but hard to create geometric elements. In many cases, you can 
use these elements as a construction aid. For example, you can use a regular polygon to place 
connection points in a circular area. Just create a regular polygon and place a connection points on 
every edge of the polygon. Now you can delete the polygon, and your connection points are perfect 
placed. 
  
There are 4 special forms available: 
  

l Regular polygon  
l Star  
l Table  
l Sine curve  

  

 
  
  

 To create a special form, select the special form mode from the mode section. 
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Select the desired form in the tab bar on the top of the dialog. Every form has special properties, which 
you have to set in this dialog. 
  
After you have confirmed this dialog, you can draw the selected form. Click on the start position of the 
form and hold the mouse button down. Move the mouse to the end position (bottom right) and release 
the mouse button. The form is now created, and you can go on with another one. 
  
You can press the SHIFT-key while you are drawing a form to force an exact square form outline. 
  
The special forms will always be created with the currently selected preferences. 
  
The forms Polygon and Star can be created either as a line or as a polygon. If the form should receive 
a brush, you have to select the option "As polygon". 
How to draw lines 
  

 
  
  

 Select the LINE mode from the mode section. 
  
The first click marks the start point of the line. Click again at another position to mark the next point, 
and so on. 
  
If you have finished the line press the right mouse button. You can now start with another line. Press 
the right mouse button again, to return to the default edit mode.  
  
When you have finished drawing lines, return to default edit mode (arrow), to change its size or 
properties. Use the changer to move the nodes of the lines. 
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You can add new nodes to your line by using the virtual nodes. There is a virtual node (blue circle) in 
the middle of every line segment. If you click to a virtual node and move this node, the virtual node will 
become a real node. So you can add new nodes to your line. 
  
You can also delete a node or split the line into 2 separate lines. Just click with the right mousebutton 
on a node and select the desired option. 
  
The line will always be created with the currently selected preferences. 
With a doubleclick on the polygon you can edit its properties like color, style, etc.  
  
The line's angle is captured to a certain value, which is displayed in the status bar. 
  

 
  
Click on the display to select another value. To turn off the angle capture temporary hold down the 
CTRL-key of your keyboard. 
  
Tip:  
The polygons are only drawn with the current defined angle capture. You can disable this angle 
capturing by pressing the <SHIFT>-key while drawing your polygon. If you press the <CTRL>-key, you 
can also disable the grid capture. 
How to draw bezier curves 
  
Bezier curves are special curves with a start point, 2 control points and an end point. The curve always 
starts in the start point and ends in the end point. The 2 control points are controlling the form of the 
curve. 
  

 
  
A simple bezier curve consists of exact 4 points. You can also define more curves in one bezier line. In 
this case, the end point of the last curve is also the start point of the next curve, so it will take 3 points 
for every additional curve (2 control points and 1 end point). Therefore a bezier curve consists at least 
of 4 points, and 3 points for every additional curve, so altogether either 4,7,10,13,... or more points.  
  

 To draw a bezier curve select the BEZIER mode from the mode section. 
  
The first click marks the start point of the curve. Click again to set the first and the second control point 
and at least the end point of the curve. For an additional curve you can now click again to set next 2 
control points and the end point. To finish drawing just click with the right mouse button. You can now 
start with a new bezier curve. Press the right mouse button again, to return to the default edit mode.  
  
While you set the 2 control points of a curve, the curve can not being displayed, because the final form 
of the curve depends on the end point. But don't take this to heart, you can move the control points 
later to define the form of your curve exactly. 
  
When you have finished drawing bezier curves, return to default edit mode (arrow), to change its size or 
properties. Use the changer to move the nodes of the curve. 
  
The bezier curve will always be created with the currently selected preferences. 
  
With a doubleclick on the bezier curve you can edit its properties like color, style, etc.   
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How to draw dimensions 
  
The dimension function allows you to create simple dimensions on your drawing: 
  

 
  
  
A dimension has 2 or 3 control-points, depending of the dimensioning type. These control-points have to 
be set one after the other if you create a new dimension. You can change these control-points anytime 
after you have created a dimension with the changer. 
  
  
Creating a new dimension 
  

 Select the DIMENSION mode from the left toolbar. 
  
To change the kind of dimension, you can click on the little red triangle, then select the desired type 
from the list: 

l Normal  
l Radial  
l Diameter  
l Angular 

Now you can place the needed control-points of your new dimension by clicking their positions on your 
drawing. Move the mouse after every click to see the effect of the control-points. After 2 or 3 clicks your 
dimension is completed. 
You can cancel the creating of a dimension evereytime with the right mousebutton. 
  
You can define the design (color, font, arrows, etc.) which will be used for new dimensions. 
To edit these settings, call the function General settings... from the Options menu and the select the 
entry Dimensions in the left list. 
  
  
Edit an existing dimension 
Select the desired dimension. You can now edit the control-points of the dimension with the changers. 
  
With a doubleclick on the dimension you can call the dimension dialog to edit special properties of your 
dimension: 
  

Seite 12 von 56Introduction

12.10.2011file://C:\Dokumente und Einstellungen\Lot\Lokale Einstellungen\Temp\~hhD434.htm



 
  
  
Diameter: 
If pressed, the diameter character will appear in front of the numeric value. 
  
Prefix: 
Any text, that will appear in front of the numeric value. 
  
Value / Auto: 
If Auto is selected, the numeric value will be set automatically. 
You can either enter a fixed numeric value, if you deselect the Auto function. 
  
Suffix: 
Any text, that will appear behind the numeric value. 
  
Tolerances: 
Here you can enter tolerances for special dimensions. 
The tolerances will appear above and below behind the numeric value. 
  
Design: 
In this section you can edit the design of your dimension. 
  
Set to default: 
With this button you can change the design to the default values. These default values are fixed and 
they are corresponding to the general design of dimensions. 
  
  
  
How to mark connections 
  
Crossing lines can be marked with a point.  
  

 Select the CONNECTION mode from the mode section. 
  
Click to the positions, that you want to be marked as a connection. 
  
When finished press the right mouse button, to return to default edit mode. 
How to add text labels 
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 Select the TEXT mode from the mode section. 
  
Click to the position, where you want the text to be created. The label property dialog opens. 
  

 
  
You can now enter the text and the text height in steps of 1/10 mm.  
You can also determine if the alignment of the text label. The text position (left, center or right) of the 
text will be fixed, if the text is changed. 
  
With the button '...' you can call an extended text dialog. Here you can insert variables and text 
constants. For more information see also Variables and text constants. 
  
  
External and Internal links:  
You can change normal text labels into active links. 
There are 2 different kinds of active links: 
  

l External link: 
Herewith you can create a link to a website (e.g. "www.abacom-online.de") or to a special file 
(e.g. a PDF document with a datasheet).  

l Internal link: 
With these links, you can jump to another places within your project. You can even jump to 
another pages within your project. You can follow these links with simple doubleclicks. So you can 
create interactive schematics.  
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For more information see also Active links. 
  
Close the dialog with OK to create the label. You can now click again to create another label or use the 
right mouse button to return to default edit mode. 
  
With a doubleclick on a label, you can call this dialog again to change any settings. 
  
If you select a label, you can change its size, form or direction with the sizer. 
How to create TextRects 
  

 
  

 Select the corresponding mode from the mode section. 
  
Click to the top left corner of the textrect, hold the mouse button down and draw a text rectangle and 
release the mouse button. The following dialog will appear: 
  

 
  
Here you can edit the text. If you edit the text, you can see the changes also on your plan. 
You can also change the font and the text-alignment. 
  
A double click on a textrect opens the dialog again for changes. 
  
If you select a textrect, you can see the outline on the screen. This broken line will not appear on any 
printout or export. If your text will overlap this outline, it will be clipped. The outline defines the 
maximum size  of the textrect. 
  
If you select a textrect, you can change its size, form or direction with the sizer. 
How to import bitmaps 
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 Select the corresponding mode from the mode section. 
  
Click to the diagram to determine the position of the bitmap. Select a bitmap file from the file dialog. 
The bitmap will now appear in your diagram. 
  
You can also select the menu-item Import picture... from the File menu. 
  
sPlan supports the BMP and the JPG format. If you need to import graphics in another format, you have 
to convert these graphics into BMP or JPG format with another application. 
  
If you select a bitmap on your plan, you can change its size, form or direction with the sizer. 
Element properties 
  
You can change the properties of each element, with a double click on the element, to open its property 
dialog. You can also select the PROPERTIES item from the local popup menu (right mouse button on the 
element). 
  
Certain objects have certain properties: 
  

l For rectangles, circles and polygons the dialog "Pen and brush" opens.  
l For lines and bezier curves the dialog "Line properties" opens.  
l For dimensions the dialog "Dimension" opens.  
l For labels the dialog "Text properties" opens.  
l For textrects the dialog "TextRect" opens.  
l For components and symbols the dialog "Component properties" opens. 

Pen and brush properties 
  

 
  
  
Here you can select the pen and the brush of closed elements like rectangles, circles or polygons. 
  
Pen (Outline): 
You can set the pen-style, the width and the color of the outline. 
The option 2-colored lets you create a 2-colored outline. This option only makes sense in combination 
with a dotted or dashed line-style. A solid line can not have 2 colors. 
  
Brush (Fill): 
You can set a color and a brush-style (solid, hatched, etc.). 
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Default: 
With this button you can reset the values the default values of sPlan. 
  
Line properties 
  

 
  
Here you can select the properties of a line. 
  
At the top you can set the line-style. The symbols left and right beneath the line style define the start 
and end style of the line. You can select several symbols like arrow, diamond, etc.  
  
Width: 
The width of the line in 1/10 mm.  
  
Arrow size: 
The arrow size determines the size of the start and end styles of the line. You can select between small, 
medium and large. 
  
Color: 
You can define the color of the line. 
  
2-Colored: 
The option 2-colored lets you create a 2-colored outline. This option only makes sense in combination 
with a dotted or dashed line-style. A solid line can not have 2 colors. 
  
Default: 
With this button you can reset the values the default values of sPlan. 
Dimension properties 
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Diameter: 
If pressed, the diameter character will appear in front of the numeric value. 
  
Prefix: 
Any text, that will appear in front of the numeric value. 
  
Value / Auto: 
If Auto is selected, the numeric value will be set automatically. 
You can either enter a fixed numeric value, if you deselect the Auto function. 
  
Suffix: 
Any text, that will appear behind the numeric value. 
  
Tolerances: 
Here you can enter tolerances for special dimensions. 
The tolerances will appear above and below behind the numeric value. 
  
Design: 
In this section you can edit the design of your dimension. 
  
Set to default: 
With this button you can change the design to the default values. These default values are fixed and 
they are corresponding to the general design of dimensions. 
  
Text properties 
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Here you can enter the text and the text height in steps of 1/10 mm.  
You can also determine if the alignment of the text label. The text position (left, center or right) of the 
text will be fixed, if the text is changed. 
  
With the button '...' you can call an extended text dialog. Here you can insert variables and text 
constants. For more information see also Variables and text constants. 
  
  
External and Internal links:  
You can change normal text labels into active links. 
There are 2 different kinds of active links: 
  

l External link: 
Herewith you can create a link to a website (e.g. "www.abacom-online.de") or to a special file 
(e.g. a PDF document with a datasheet).  

l Internal link: 
With these links, you can jump to another places within your project. You can even jump to 
another pages within your project. You can follow these links with simple doubleclicks. So you can 
create interactive schematics.  

  
For more information see also Active links. 
TextRect properties 
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Here you can edit the text. If you edit the text, you can see the changes also on your plan. 
You can also change the font and the text-alignment. 
Component properties 
  

 
  
Identifier 
The identifier consists of a character, followed by a number (e.g. R1). You can enter an identifier for 
each individual component, or enable the very useful option automatic numbering. 
  
Automatic numbering 
If you want to use the automatic numbering option, simply enter a character like "R" (without number!) 
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to the field identifier and activate the option AUTOMATIC NUMBERING. The software will find all 
components with identifier "R" and number them automatically. 
  
After you have deleted components from the diagram, some numbers may miss. In that case you can 
call Renumber components...  from the Functions menu item, or from the toolbar. 
  
Identifier visible 
Disable this option for some symbols, which don't need an identifier displayed (like arrows, etc). 
  
Type/Value 
Use this field to enter a components type or value, like "1k" for a resistor, or "BC547" for a transistor. 
  
Request type/value 
The option REQUEST TYPE/VALUE enables the data request, when the component is dragged and 
dropped to the diagram. Use this option for components, that need type or value information, which you 
don't know, when the component is being designed. You can also use this feature, to confirm a 
predefined default value. 
  
Type/value visible 
Disable this option if a component has no type or value, or if you don't want to display it for some 
reasons. 
  
Parent (accept childs)  
If you select this option, the component is defined as a parent. 
Here you can read more about Parent-Child relations. 
  
Add to components list 
If this option is selected, the component will appear in the component list. Disable this option for simple 
symbols like arrows, which should not appear in the component list. 
  
Description 
If you like, enter a short description to this field, which will be displayed beyond the component in the 
library. Use short text to keep the library small! 
  
Editor 
Press this button to activate the component editor. 
  
Contacts 
Components can be equipped with so-called contacts, which are editable pin descriptions. They allow to 
change descriptions easily without opening the component editor.  
If the component includes contacts, you can extend the dialog, and the contact list is shown. Here you 
can edit the pin descriptions of the component contacts. 
The clipboard 
  
The clipboard functions are well known from almost all Windows applications: 
  

l Cut  
l Copy  
l Paste  
l Duplicate  

  
Clipboard functions are called from the EDIT item in the main menu, from the toolbar, or from the local 
popup menu. 
  
Cut 
This function copies all selected objects to the clipboard and deletes all selected objects from the 
diagram. 
  
Copy 
This function copies all selected objects to the clipboard. Selected objects will remain in the diagram. 
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Paste 
This function adds the contents of the clipboard to the diagram. The objects will "stick" on the mouse 
cursor, and you can place it with a click. 
  
Duplicate 
This function performs COPY and PASTE in one step. 
  
  
You can also copy your drawing to the clipboard, to use it with other applications (e.g. for 
documentations, etc.). Other applications can use the paste command to get the bitmap. 
Here you can read more about Copy a bitmap to the clipboard. 
  
  
Copy a bitmap to the clipboard 
  
You can copy your drawing to the clipboard, to use it with other applications (e.g. for documentations, 
etc.). Other applications can use the paste command to get the bitmap. 
  
Select Clipboard... from the File menu: 
  

 
  
Resolution: 
Here you can set the resolution of the bitmap. 
The quality of the resulted bitmap is as better as higher you set the resolution. But this will also result in 
higher memory consumption. This may cause a problem with extended drawings and high resolutions, 
because Windows limits the usage of the clipboard. In this case simply decrease the resolution. 
  
Output: 
Here you can select, if you want to copy the whole plan or only the selected elements of your drawing. 
  
Zoom 
  
The zoom function is a very important feature of sPlan. Only this function allows to display the whole 
drawing, and then change the display into a detailed view in a big format. 
  
Zoom with mousewheel 
This is the best and most comfortable way to zoom and navigate in your drawings. 
If the mouse is over your drawing, you can zoom with the mousewheel. If you zoom IN, the mouse 
position will automatically be centered, so you can navigate to every place on your drawing simply by 
zoom a little IN and OUT. 
  
  
There are also some other obsoleted zoom functions: 
  

 Select the ZOOM mode (magnification glass) from the mode section. 
  
You can now increase magnification, clicking with the left mouse button to the diagram. The right mouse 
button decreases magnification. You can also frame the area you want to zoom to. 
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Three additional zoom functions are available from the toolbar: 
  

l Zoom page  
l Zoom elements  
l Zoom selected elements  

  
Rotating, mirroring and arranging objects 
  
All elements can be easily rotated, mirrored and arranged. 
The following functions are available: 
  

l Rotate  
l Mirror (horizontal)  
l Mirror (vertical)  
l Set to front  
l Set to back  

  
The functions are available in the Functions menu, from the toolbar or from the local popup menu. To 
perform one of these functions, first select the objects and then call the function. 
  
Rotate 
With the rotate-button in the toolbar you can rotate selected elements 90° clockwise. 
With the "Rotate..." entry in the "Function" menu all selected elements will be rotated clockwise with 
an editable angle. You can hold down the SHIFT-key on your keyboard to keep text objects in readable 
position, while rotating objects. 
You can rotate selected elements also with your mouse (see sizer and changer). 
  
Mirror 
All selected objects will be mirrored along the vertical or horizontal axis. Text objects won't be mirrored, 
this will keep the text readable. You can hold down the SHIFT-key on your keyboard while mirroring, to 
force that text elements will be mirrored too. 
  
To front / to back 
These functions will change the z-order of the selected objects. The effect of these functions can only be 
seen, if two or more objects were overlapped. Use Set to front to make an object lay on top of all 
others, use Set to back to have it overlapped from all other objects. 
Adjusting elements 
  
With this function you can adjust elements to each other.  
First you have to select all elements, that should be adjusted. Then select the ADJUST button from the 
toolbar and select the direction of adjustment. The following adjustments are available: 
  

l Top  
l Bottom  
l Left  
l Right  
l Horizontal  
l Vertical  

  
Note that you have to select at least 2 elements, to call the ADJUST function. 
Coloring elements 
  
Use this function to change the color of all selected elements at once, instead of calling the property 
dialog for each individual object. 
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Select the objects that have to be changed and call the Colorize elements... function from the 
Function menu. A color dialog allows you to select a new color. You will not see the effect while objects 
are still selected (magenta). All lines and fillings will appear in the new color, except objects that have a 
white filling. The white filling is reserved for components, which often contain text objects like 
descriptors, which should always be readable. 
Build and split groups 
  
Building groups 
Objects can be combined to groups, to make them selectable with one single click. Groups also protect 
their elements against unwanted changes in positions, color, etc. Members of a group can not be 
deleted separately. You need at least two elements to build a group and a group can contain one or 
more sub-groups. To build a group select the elements and call Functions -> Build group from the 
main menu or from the corresponding button in the toolbar. 
  
Splitting groups 
If you wish to edit a group member separately you have to split the group. Select the group and call 
Functions -> Split group. If the group contains subgroups, these will stay unaffected. You may repeat 
this action with the subgroup. 
Magnetic lines 
  
Magnetic lines are used as a construction aid, so they have no style properties and will not be printed. 
They are helpful to find the correct position when objects are moved. Elements are adjusted to magnetic 
lines automatically, when an element is moved near to a magnetic line. 
  
Adding magnetic lines 
An easy way to create a new magnetic line is to draw it from the ruler. Just click on a ruler, keep the 
mouse button pressed and move the mouse on your diagram. If you release the mouse button, the 
magnetic line will be created. 
  
You can also select New magnetic line vertical or New magnetic line horizontal from the 
Functions->Magnetic lines submenu. The new line will appear in the diagram. 
  
  
Moving magnetic lines 
Move the mouse above a magnetic line. The cursor will show that you can move the line. Click to the 
magnetic line and move it to the new position, while holding down the left mouse button. 
  
Deleting magnetic lines 
Click to the magnetic line. The line will change its color to red. Now select Delete from the main menu 
or from the toolbar or press the DEL-key.  
  
An easier way to delete a magnetic line is to draw it back to the ruler. Just click on a magnetic line, 
keep the mouse button pressed and move the magnetic line to a ruler. If you release the mouse button, 
the magnetic line will be deleted. 
  
Fix magnetic lines 
You can call this function from the Functions->Magnetic lines submenu to fix all magnetic lines on 
your page. This will protect all magnetic lines against moving or deleting. In this mode, it is also not 
allowed to add new magnetic lines to your page. You can always leave the fixed mode if you select this 
function again. 
  
Hide magnetic lines 
You can call this function from the Functions->Magnetic lines submenu to hide all magnetic lines on 
your page. In this mode, it is also not allowed to add new magnetic lines to your page. You can display 
your magnetic lines if you select this function again. 
Using forms 
  
Every page can have its own background form. The form is a separate layer, which lies under the true 
diagram. Normally, the form is only visible, but you can't select or edit any elements from the form. The 
advantage is that elements from the form do not disturb your work, when editing the circuit.  
You can create your own forms, or edit existing forms just like you want. 
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How to create a user defined form 
If you want to edit the form of the current page, you have to open the form for editing. Select the 
function Edit form from the menu Forms. The diagram will now hide, and the form is open for editing. 
Now you can edit the form with all drawing features of sPlan. 
  
If you have finished, you have to deactivate the function Edit form, just click on the same menu entry. 
Now the form will be set to back and your diagram is shown again. 
  
How to save forms to file 
A form that once has been drawn can be saved to a file, so that the form can be used whenever needed 
for another pages. Call Save form to file... from the Forms menu. Files that contain a form, have the 
extension *.SBK. 
  
How to load forms from a file 
You can load existing forms to the current page. Call the Load from file... function from the Forms 
menu and select a file with the extension *.SBK. Note that any existing form on the current page gets 
lost, if you load a new form. 
Operate with several pages 
  
A circuit diagram that is drawn with sPlan can consists of several pages. Large projects should be split to 
smaller modules, so that every module has its own page in the document. For example the circuit 
diagram of a power amplifier, can be divided into the following modules: 
  
Power amp = Supply + Preamp + Sound control + Main stage 
  
The diagrams of the four modules can be drawn on individual pages, and all together can be saved to a 
single file called "POWERAMP.SPL" for example. 
  
You can add as many pages to a project as you like, and give them an individual name. On bottom of 
the editor you find a register with an entry for every page that exists in the project. Click on one of 
these entries to activate the page. 
  
You can get a local context menu, if you press the right mouse button on the page register. Here you 
will find functions to load and save pages to files, or to change the order of pages. 
  
Page properties: 
Here you can change the properties of the paper sheet. 
The dialog allows you to adjust the paper format, the orientation and you can enter a name for the page 
(see also Page properties). 
  
Create new page: 
A new, empty page will be added to your project. The new page is named "PAGE x". 
To edit the page properties call Page properties. 
  
Copy page: 
Use this command to make a copy of the current page. 
  
Delete page: 
Use this command to delete the current page from your project. You will be asked to confirm the 
deletion. 
A project must at least contain one page. You can not delete a page, if the page is the one and only in 
your project. 
  
Sort pages:: 
If you want to change the sequence of your pages, you can use this command. Here you can easily sort 
your pages by drag & drop the pages in a list. 
  
Goto page...  
If you have many pages in your project, this function may be helpful. You can select a page directly 
from the list of available pages. 
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Saving pages 
This feature was designed for exchanging single pages with other projects. Call Save page... from the 
Page menu to save the current page to a file. Single pages have the extension *.BLT. 
  
Loading pages 
You can load existing single pages. Call Load page... from the Page menu to add the page to your 
project. 
Line and fill preferences 
  
If you prefer certain styles for lines or fillings, these parameters can be set previously, and were used 
for all drawing operations. Click to the corresponding buttons in the status bar to change the 
preferences for lines and fillings. 
  

 
  
A dialog will open that lets you change the parameters. 
General Settings 
All settings in sPlan can be made in one dialog. 
You can call this dialog from the Options menu Options then call General settings... 
  
You can select the category in the left list of this dialog: 
  
General settings 
Working directories 
Libraries 
Font presets 
Text constants 
User variables 
Grid 
Dimensions 
Scale 
Autosave 
General Settings 
Here you can made elementary settings for the work with sPlan: 
  
You can call this dialog from the Options menu Options then call General settings... 
Select the category General settings in the left list: 
  

 
  
Pages with page numbers 
If activated, all pages will get the pagenumber as a prefix. 
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Components with page numbers 
If activated, all components will get the pagenumber in their identifier as a prefix. 
  
Smooth text 
The text will be displayed smooth (antialiasing). 
Disabling this option may increases the display speed, but will the display of the text will get more 
worse. 
  
Show ruler 
Shows or hide the rulers. 
  
Ruler in white 
Display the rulers either in white or in gray color. 
  
Snap to grid 
This activates the grid capture. 
You can set this option also in the toolbar at the bottom of sPlan. 
  
Rubber band 
This activates the rubber band function. 
You can set this option also in the toolbar at the bottom of sPlan. 
  
Snap to connections 
This activates the automatic snap to connections function. 
You can set this option also in the toolbar at the bottom of sPlan. 
  
Compress embedded bitmaps when saving 
If activated, the bitmaps within a drawing will be packed while you are saving the file. This will drastic 
decrease the resulting filesize. 
  
Keep Windows-Fileinfo when saving 
If activated, external fileinfos which may are give to this file will be kept. 
This function may cause a great delay while saving your files on a network, so this option should only be 
activated if it is really necessary. 
  
  
  
  
Working directories 
  
You can define default-directories for the work with sPlan. 
  
Select General settings... from the Options menu, then select Working directories in the left 
section: 
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In this dialog you can define defaults for the working-directories. 
If you leave these fields empty, sPlan will always remember the last used directories on the next start. 
  
Libraries 
  

 
  
This dialog allows you to select, create, delete or administrate your libraries. Read the following 
chapters for further information.  
  
Selecting a library 
  
Creating new libraries 
  
How to rename and delete libraries 
  
Library administration 
  
  
Font presets 
  
You can define default-fonts for the work with sPlan. 
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Select General settings... from the Options menu, then select Font-presets in the left section: 
  

 
  
Here you can define fixed font presets, which will be used every time sPlan is started. 
You can also define, that sPlan will always remember the last used fonts. 
Definition of text constants 
  
You can define as many text constants as you want.  
  
Select General settings... from the Options menu, then select Text constants in the left section. 
  

 
  
In this dialog you can edit, delete or extend your text constants. 
Definition of variables 
  
You can define as many user variables as you want. 
Select General settings... from the Options menu, then select User variables in the left section. 
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In this dialog you can edit, delete or extend your variables. 
Every variable has a NAME and a TEXT CONTENT. The name is not case sensitive. 
  
If you change the text content of a variable later, all labels which use this variable will be changed 
automatically. 
Dimension presets 
  
Here you can define the design for new dimensions. 
Select General settings... from the Options menu, then select Dimensions in the left section: 
  

 
  
Set to default: 
With this button you can change the design to the default values. These default values are fixed and 
they are corresponding to the general design of dimensions. 
  
Assign to all dimensions: 
With this button you can change all dimensions which are already in your drawing to this new values. 
  
Scale 
  
Select General settings... from the Options menu, then select Scale in the left section: 
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You can also click on the displayed current scale in the statusbar at the bottom of sPlan. 
  

 
  
Here you can enter a new scale if necessary. sPlan will consider this scale in all coordinates, rulers, 
dimensions, etc. 
AutoSave 
  
This option can be used for automatic saving within given intervals. 
  
Select General settings... from the Options menu, and then select Autosave in the left section: 
  

 
  
If Autosave is activated, sPlan will save your work regularly to a backup file. The backup file has the 
same filename as your project, but the extension will be changed to *.bak.  
  
Don't forget to save your work regularly, even if Autosave is activated. The backup feature was just 
designed to give you additional safety. 
  
Whenever you have to restore your work from a backup file, you can rename the ".bak" extension to 
".spl". After that, you can load this file like any other sPlan-file. 
Symbols and components 
  
Symbols and components are the most important parts of a circuit diagram. On the left of the main 

Seite 31 von 56Introduction

12.10.2011file://C:\Dokumente und Einstellungen\Lot\Lokale Einstellungen\Temp\~hhD434.htm



window, you find the component library, that contains symbols, components and parts on several 
pages. You can add new pages, add components, exchange components, and so on, to customize the 
library. 
  
The library pages are listed in alphabetic order in the combo box on top of the library. Use this list to 
open a page of the library. 
  
The components can easily dragged & dropped to your drawing. 
What is a component? 
  
Components are special groups of the basic elements like circles, rectangles, etc. Basically the 
component component "resistor" consists of a rectangle, with two lines, representing the wires. When 
these elements become a component, the following happens: 
  

l 2 new labels will be added (Identifier and Type/Value)  
l a group is built from these elements  

  
For example, the identifier can contain "R1" and the field can be set to "1k" for a 1-kOhm-resistor. This 
is the same with all components that you will find in the library. 
  
sPlan offers some additional features, to make the handling with components more  easy and 
comfortable: 
  

l The label for the identifier can be hidden, if not necessary  
l The label for type/value can be hidden, if not necessary  
l You can use an automatic numbering option for the identifier  
l You can enable a request for type/value, when the component is added to the diagram  
l You can determine if components will appear in the components list or not  
l You can enter a description, which is displayed under the components in the library.  
l You can enter a comment, which is displayed in the component list.  

  
Equipped with these features, sPlan offers various possibilities for your own creation of components. A 
component must not be a component in a electronically way. You can define symbols, or any other parts 
as a component too. At least you could use sPlan for something completely different, but circuit 
diagrams! 
Editing components 
  
You can apply changes to every component, independent whether it is in the library or in your diagram. 
If you want to make general changes, you better edit the component from the library. The library 
component is like a parent to all components that are added to the diagram. Its properties will be copied 
from the library component, when it is dragged & dropped to the diagram. On the other hand, you 
should edit the component in the diagram, when changes are individual to this element. So the original 
component in the library will stay unaffected. 
  
Double click on a component to open its property dialog and to make some of the following changes: 
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Identifier 
The identifier consists of a character, followed by a number (e.g. R1). You can enter an identifier for 
each individual component, or enable the very useful option automatic numbering. 
  
Automatic numbering 
If you want to use the automatic numbering option, simply enter a character like "R" (without number!) 
to the field identifier and activate the option AUTOMATIC NUMBERING. The software will find all 
components with identifier "R" and number them automatically. 
  
After you have deleted components from the diagram, some numbers may miss. In that case you can 
call Renumber components... from the Functions menu item, or from the toolbar. 
  
Identifier visible 
Disable this option for some components, which don't need an identifier displayed (like arrows, etc). 
  
Type/value 
Use this field to enter a components type or value, like "1k" for a resistor, or "BC547" for a transistor. 
  
Request type/value 
The option REQUEST TYPE/VALUE enables the data request, when the component is dragged and 
dropped to the diagram. Use this option for components, that need type or value information, which you 
don't know, when the component is being designed. You can also use this feature, to confirm a 
predefined default value. 
  
Type/value visible 
Disable this option if a component has no type or value, or if you don't want to display it for some 
reasons. 
  
Parent (accept childs)  
If you select this option, the component is defined as a parent. 
Here you can read more about Parent-Child relations. 
  
Add to components list 
If this option is selected, the component will appear in the component list. Disable this option for simple 
symbols like arrows, which should not appear in the component list. 
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Description 
If you like, enter a short description to this field, which will be displayed beyond the component in the 
library. Use short text to keep the library small! 
  
Editor 
Press this button to activate the component editor. 
  
Contacts 
Components can be equipped with so-called contacts, which are editable pin descriptions. They allow to 
change descriptions easily without opening the component editor.  
If the component includes contacts, you can extend the dialog, and the contact list is shown. Here you 
can edit the pin descriptions of the component contacts. 
The component editor 
  
The handling of the component editor is almost the same as the main editor for the circuit diagram. It is 
equipped with all functions you will need to draw a symbol or component. 
The component data (Identifier, Type/Value) is displayed as [ID] and [VALUE]. You can move these 
labels to any position you like. You can double click them, to change the properties like font, color and 
height. The text of these labels can not be changed, because it is reserved for the component data as a 
wildcard. You cannot delete these labels, but you have already learned how to hide them, when calling 
the property dialog for a component. 
  
Contacts may be used for components with variable pin descriptions. 
  
  
There is one very important thing you'll have to deal with... The red point! 
  
The red point 
You have already heard about the grid, when editing a circuit diagram. The red point defines the 
position of the component to the grid. The red point will always fit to the grid, when the component is 
added to the diagram, no matter what the component looks like. So the positioning of the red point is 
very important, to make the component connectable within the circuit diagrams. 
  
Setting the red point is a simple as important. Move the red point to one significant point of the 
component that you have drawn. For components that have connections, move to red point exactly to 
one of the connections. The best way to do is to use the grid of the component editor. Set one 
connection and the red point exactly to a grid point. 
  
How to create your own components and symbols 
  
There are a few possibilities to create own components. The first decision you should make is, whether 
the new component must be drawn completely new, or to create it from an existing component, that is 
similar to the one you need. 
  
Creating a new component 
If you want to create a new component, click with the right mousebutton in the library and select 
Create new component... The component property dialog will open. Enter the components properties 
and the click the Editor button to open the component editor. A component must at least consists of 
one drawing element, so we use a square with 20-mm edges as default. You may now delete this 
square and draw the component you want. When finished close the component editor and the property 
dialog. Your new component will now appear in the library, on the bottom of the current page. 
  
Creating a component from an existing component 
Click with the right mousebutton to the component in the library you want to copy, then select the 
command Copy component. A copy of the component will appear in the library, on the bottom of the 
current page. Now you can edit this component. Doubleclick to the component and the component 
property dialog will open. Click on the Editor button to open the component editor. When you have 
finished, close the component editor and the property dialog. 
  
Last but not least there is another way to create a component. This is done, by selecting elements from 
the circuit diagram, and calling the function Create component from selection... from the 
Components menu. The component property dialog will open. Enter the component data or make 
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additional changes with the component editor, if you like.  
Contacts 
  
Another special feature of the component editor allows you to add so-called "contacts" to a component. 
A contact is like a label, where the text of the label is easily editable in the components property dialog. 
You don't have to call the component editor to edit these contacts. 
  
Usually you will use contacts to describe component pins. Certainly you can do this with ordinary labels, 
but some components look exactly the same, while only the connections of the components have 
different names. In that case contacts can be useful to have a component only once in a library and pin 
descriptions can be entered later, when the component is "built-in" to the circuit. 
  

 Select the corresponding button from the toolbar of the component editor, to add a contact to your 
component. 
  
The contact will now "stick" on your mouse, and you can place it with a mouse click. 
  
A double click on the contact opens the following contact dialog: 
  

 
  
Name 
Enter a name for the contact. This name is used to identify the contact, when the text is edited in the 
component property dialog. 
  
Text 
Enter a text for the contact. This text is displayed with the component in the diagram and can later be 
edited in the component property dialog. 
  
With the button '...' you can call an extended text dialog. Here you can insert variables and text 
constants. For more information see also Variables and text constants. 
  
Font 
Click to this button to define the text font and text height of the contact. 
  
  
Creating a contact list 
You can create a contact list, which contains all contacts together with there inscriptions and the 
components which belongs to them. To create the contact list call the entry Create contact list... from 
the Function menu. 
  
  
Splitting components 
  
A component can be split into the elements the component consists of. Doing this, the special 
component data will be lost. 
  
To split a component, select the desired component, and then select Components -> Split 
component from the main menu. 
Change component inscriptions 
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If you want to change the font, the color or the size of several or of all components, you can call the 
following dialog with Components -> Inscription... from the main menu. 
  

 
  
In this dialog you can edit the text height and font for the identifier, the value anf the contacts. The 
section Apply to let's you select which components should be changed. If you confirm this dialog, the 
changes will be made immediately. 
The component library 
  
Components are the most important parts of a circuit diagram. On the left of the main window you find 
the component library, that contains symbols, components and parts on several pages. sPlan offers 
several functions to customize the library: 

l Adding new pages  
l Renaming pages  
l Deleting pages  
l Create new components  
l Deleting components  
l Sort components  
l Copy components  
l Adding additional libraries  

  
The library pages are listed in the combo box in alphabetic order on top of the library. Open the list and 
click to an entry to open a certain page from the library. You can drag & drop the components from the 
library to your diagram. 
  
Press the right mouse button, while the mouse is over the library, to open a local menu, which offers all 
needed functions to edit your library. 
Display options of the library 
  
Some display options are available for the library. You can determine the number of columns that are 
filled with components or turn off the display of component names. These options are available with a 
click to the buttons on bottom of the library.  
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The buttons "+" and "–" increase or decrease the number of columns. Right from that you find a button 
that turns the component descriptions on and off. 
  
The width of the library is adjustable. Move the mouse cursor to the right border of the library. The 
cursor will appear as a double arrow. Hold down to mouse button and move the mouse, to adjust the 
width of the library. 
Editing a library page 
  
Press the right mouse button, while the mouse is over the library, to open a local menu, which offers all 
needed functions to edit your library: 
  
Edit component: 
Here you can call the properties dialog of the selected component. 
You can also doubleclick the component. 
  
Create new component: 
The component property dialog will open. Enter the components properties and the click the Editor 
button to open the component editor. A component must at least consists of one drawing element, so 
we use a square with 20-mm edges as default. You may now delete this square and draw the 
component you want. When finished close the component editor and the property dialog. Your new 
component will now appear in the library, at the bottom of the current page. 
  
Copy component: 
With this you can copy a component within the library page. The copy of the selected component will 
appear at the bottom of your library. You can now edit this component. 
  
Delete component: 
This command deletes the selected component from the library. 
  
New library page: 
You will be asked to enter a name for the new page. The library pages are sorted in alphabetical order, 
so the name determines the position of the entry in the listbox. After that the new (empty) page opens 
in your library. 
  
Copy library page: 
You will be asked to enter a name for the new page. The library pages are sorted in alphabetical order, 
so the name determines the position of the entry in the listbox. After that the new page opens in your 
library and contains the same components as the source page. 
  
Rename library page: 
You will be asked to enter a new name for the current page. The library pages are sorted in alphabetical 
order, so the name determines the position of the entry in the listbox. 
  
Delete library page: 
This function deletes a complete page with all its components from the library. You will be asked to 
confirm the DELETE command. If you confirm with OK the library page and its components will be gone 
forever. 
  
Info library page: 
Here you can get information about the current library page like filename, numbers of components, etc.
  
Explorer: 
This function runs the Windows-Explorer with the current library folder opened. 
This is only for experienced users, to handle the library files (*.lib) on file level. Here you can copy, 
delete, add or rename the library files. 
Here you can get more information about Rename, import backup of library files.  
  
How to sort (move) components within a page 
To sort the components within a page, just drag & drop the component to the desired position. While 
you are dragging a component, the new position will be marked with a little red square. 
  
How to exchange components between library pages 
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To move or copy components to another library page do this: 
  

l select the library's source page and add one or more components to your plan  
l select the components, that you have added to the diagram  
l select the library destination page  
l click with the right mousebutton on the selected components and select Add component(s) to 

library  

  
All selected components will now appear at the bottom of the library page. Delete the source 
components from your plan, if you like. 
The file-structure of the library 
  
With sPlan you can work with several libraries, each with several pages. A library is stored in a certain 
directory on your hard disk. Each page of this library is stored as a file (*.lib) in this directory. 
  
2 libraries are installed together with the program: 
  
Standard 
This is the default library, which is installed in the \BIBO directory in the application data path. 
  
User 
This library was made by sPlan users and can be found in the \USER subdirectory in the application data 
path. 
  
Both directories contain several files. Each file contains the data of a library page. A new file is created 
when a new page is added to a library. The filename is LIBx.LIB, where x stand for a serial number. 
  
The command Info library page... from the local menu of the library (right mouseclick on the library) 
gives you information about the current library page and displays the directory and the filename, where 
the library file is stored. 
  
The Explorer function (also available from the local menu of the library) runs the Windows-Explorer 
with the current library folder opened. This is only for experienced users, to handle the library files 
(*.lib) on file level. Here you can copy, delete, add or rename the library files. Here you can get more 
information about Rename, import backup of library files.  
Changing the  library 
  
With sPlan you can work with several libraries. Maybe you have one library with electronic parts, and 
another library with hydraulics parts. After the installation of sPlan there will be already 2 different 
libraries installed (Standard and User).  
  
To change the library just click on the button with the book-icon left beneath the library listbox: 
  

 
  
A list with all available libraries appears, and you can select the desired library from this list. 
With last entry Libraries... you can call the dialog to add new libraries, delete rename or manage 
libraries. 
  
Creating new libraries 
  
There are different reasons, why you should create a new library: 
  

l Libraries may become too large to be clear  
l Components from various themes are used with sPlan  
l You want to share libraries on a network  
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The first thing to do is, to create a new directory (folder) anywhere on your system (or network). 
Therefore use the Windows Explorer. You may now copy library files (*.LIB) to this directory or leave 
the directory empty for the present. 
  
To register the new library in sPlan just click on the button with the book-icon left beneath the library 
listbox: 
  

 
  
Now select the last entry Libraries... 
  

 
  
  
Click to the New button. A new entry is added to the list. 
  
Now click on the browse button "..." and locate the new library directory, which you have created 
before. 
  
After locating the library path, you can enter a clear name for the library to the edit field below the path.
You can now use your new library as any other library. 
  
How to rename and delete libraries 
  
To rename or delete a library just click on the button with the book-icon left beneath the library listbox:
  

 
  
Now select the last entry Libraries... 
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Select the desired library in the library list. You can now select another path (browse button "...") for 
the library or enter a new name for the library.  
  
To remove an entry from the library list, click on the Delete button. You have to confirm this operation. 
Only the entry of the library list will be deleted. The library itself will remain unaffected. So you can add 
the library again, if necessary. 
Library administration 
  
sPlan offers an integrated library administration, which makes it easy to move, copy or delete pages of 
libraries. 
Click on the button with the book-icon left beneath the library listbox: 
  

 
  
Now select the last entry Libraries... 
  

 
  
Click on the Manage... button to open the library manager: 
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You can now exchange library pages between two libraries. Select two libraries (for example: USER and 
STANDARD) from the list box on top of both lists. The lists show all pages, contained in the libraries. 
  
The buttons for Move, Copy and Delete are disabled for the present. They become enabled, if you select 
entries in the lists. 
  
You can now select list entries (pages) and move or copy them to the other library. Press the DELETE 
button to delete a page from a library (immediately!). 
  
Rename, import and backup of library files 
  
How to rename library files 
Library files (pages) use the file extension *.LIB. You can simply browse and rename these files using 
the Windows Explorer. This will make sense if you want to distribute a library page. A name like 
TUBES.LIB is much clearer than LIB12.LIB. Make sure that you keep the file extension .LIB when 
renaming library files. 
  
Import of library files 
If you received a new library file from a colleague or from our homepage www.abacom-online.de, you 
can copy the library files (*.lib) to any library directory. Take care not to overwrite existing files! If a file 
already exists in your library, you will have to rename this file before copying. In some cases libraries 
are published as circuit diagrams (*.SPL) on the Internet. In that case you have to open the file and add 
the contained components to your library manually. 
  
Backup of libraries 
To create a backup of your libraries, simply make a copy of all library directories and the included *.LIB 
files. If you have to reinstall sPlan, you can restore your libraries from the backup files. If you had 
created your own libraries, you will have to register these libraries to sPlan again (See "Creating new 
libraries"). 
Variables and text constants 
 
What are variables and text constants 
  
Usage of variables and text constants  
  
Definition of text constants 
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Definition of variables 
What are variables and text constants 
  
You can use text constants and variables instead of static text within the text labels in sPlan. 
  
Text constants 
Text constants are saved text blocks, which are available at any time. If your diagrams contains often 
needed phrases, you can save these phrases as text constants. Any time you have to enter these 
phrase, you can call the text constant. So you don't have to type in the phrase. 
  
Variables 
Variables are an extended form of text constants. Every variable has a NAME and a TEXT CONTENT. The 
name is a wildcard for the text content, and is always framed between the characters "<" and ">". For 
example a variable name can looks like <PROJECTNAME>. 
  
On your diagram, not the variable name will appear but their text content. If you have assigned the text 
"Amplifier Project 54X-922" to the variable <PROJECTNAME>, a label with the content 
<PROJECTNAME> will be displayed as "Amplifier Project 54X-922". If you change the text content 
of this variable, the displayed text on your diagram will change immediately, everywhere in your 
project. 
  
There are 2 kinds of variables in sPlan: The predefined variables and the user variables. The 
predefined variables are always and everywhere available. The user variables can be defined by the user 
within a project, and they are available only in the project where they are defined. 
  
The predefined variables are: 
  
<TIME>  
The current time 
  
<DATE>  
The current date 
  
<PAGENO>  
The current page number 
  
<PAGECOUNT>  
The count of pages in the current project 
  
<PAGENAME>  
The name of the current page 
  
<FILENAME>  
The name of the file (only if saved)  
  
<FILEPATH>  
The path of the file (only if saved)  
  
<VERSION>  
The current version of sPlan 
  
The predefined variables can be used just like the user defined variables. You can also mix the variables 
with static text. For example a label with the text: 
  
"This is page <PAGENO> of <PAGECOUNT>" 
  
will be displayed on the diagram as: 
  
"This is page 2 of 4" 
  
(provided that this label is on page 2 of total 4 pages) 
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If you copy this label to another page, or the total number of pages changes, the displayed text will 
change immediately. 
  
  
There are 3 additional variables, which are important is you are using Parent-Child relations. 
  
<PARENT_ID>  
Identifier of the parent 
  
<PARENT_VALUE>  
Value of the parent 
  
<CHILDNO>  
Number of the child 
  
<CHILDCHAR>  
Alphabetical character of the child-number (a,b,c,...) 
  
These 4 variables are the wildcards for the automatic designation of the childs, 
Here you can find more information about Parent-Child relations. 
Usage of variables and text constants 
  
Whenever you can edit a text label in sPlan, you can also extend this text with variables and text 
constants. On the right on these edit fields exists a "..." button: 
  

 
  
With this button you can call an extended text dialog, which makes it easy to insert variables and text 
constants. 
  

 
  
To insert a variable or a text constant just click on the corresponding button. A list of available entries 
will be displayed, and you can simply select the entry you want. The variable or text constant will be 
inserted at the current cursor position in the edit field. 
  
Of course, you can type in the text manually, but with this dialog it is much easier. 
  
With the 2 buttons Define... you can define or edit user variables or text constants. 
Automatic component numbering 
  
Components in circuit diagrams are usually named with numbered identifiers, like R1, R2, R3 and so on. 
sPlan can do this automatically for you, if you want. 
  
You can enable or disable this option for every component individually. Double click to a component, to 
open its property dialog. 
  
If you want to use the automatic numbering option (let's say for a resistor), simply enter a character 
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like "R" (without number!) to the field IDENTIFIER and activate the option AUTOMATIC NUMBERING. 
The software will find all components with the identifier "R" and number them automatically. 
  
We suggest making changes like that to the components in the library, so that all copies get the same 
properties, when you drag & drop them to the diagram. 
  
The software will NOT renumber your parts, if you delete components from the diagram. In that case, 
you can call Renumber components... from the Functions menu (or from the corresponding button 
in the toolbar). 
  

 
  
Here you can select the pages, which should be included in the automatic renumbering. 
  

 
  
Here you can select if you want a geometric sort or not. 
  
Sort option: None 
Components are numbered in the order you have added them to the circuit. 
  
Sort option: Columns 
The numbering function starts with the first column, searches components downwards and continues 
with the next columns. 
  
Sort option: Rows 
The numbering function starts with the first row, searches components rightwards and continues with 
the next row. 
  
Geometrical grid 
This parameter determines a square, which is used for the component search in rows or columns. The 
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renumbering starts with all components in the first square at the top left position of your diagram. Then 
the square is moved along the row or column, and so on. Depending on the square size, to result of the 
renumbering can be different. 
Component lists 
  
An important function of sPlan is the creation of component lists. 
Component lists can be created automatically. After creation you can edit, print, save and load them. 
Call Create component list... from the Functions menu, or click on the corresponding button in the 
toolbar.  
  

 
  
You can select one or more pages that are considered for the component list: 
  

 
  
The list will appear in its own text editor, so you can make changes if you like. You first have to close 
the components list editor, before you can continue your work on the circuit diagram. 
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There are some useful options when creating components lists: 
  
Collect equal values 
This option can be useful, to shorten a list which contains lots of identical parts. 
  
      R1      = 1k 
      R2      = 1k 
      R3      = 1k 
  
...will become... 
  
      R1,R2,R3      = 3 x 1k 
  
Caution: 
The list will be recreated, when you activate this option, and your changes will be overwritten. 
  
File data 
Use this option to display additional information in the component list: 
  

l Time and date  
l File path and name of the project file  
l Page name  

  
Caution: 
The list will be recreated, when you activate this option, and your changes will be overwritten. 
  
Sort option: Quantity 
The components that are used most will appear on top of the list. 
  
Sort option: Alphabetical 
The components will appear in alphabetic order. 
  
Print 
Click to the button PRINT to get a printout of the component list. Feel free to adjust left and right border 
before. 
  
Copy 
Click the COPY button the copy the components list to the Windows clipboard. After that, you can paste 
the data into other applications. 
  
Save 
The component list can be saved to a file, using Rich Text Format (*.RTF), which can be used with most 
text editors. 
  
Open 
Use this to load a previously saved component list into the editor. (Do NOT use FILE->OPEN from the 
main menu, this is for diagrams only! ) 
  
Export 
You can export the component list. Exported component lists can be imported from other programs like 
EXCEL. 
  
Close 
Click CLOSE to continue your work on the circuit diagram and to close the components list editor. 
Active links 
  
With sPlan you can create so called active links. 
An active link is always bound to a label. There are 2 different kinds of active links: 
  
External link: 
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You can create a link to a website in the internet, or to a special file (e.g. a PDF document with a 
datasheet). 
  
Internal link: 
You can create active links from one place on your diagram to another place. It doesn't matter, if the 
link is on the same page or on another page. You can follow the links with a simple mouse click, so you 
are able to create interactive circuit diagrams. 
  
The link will be created in the property dialog of a label. Call this dialog with a double click on a label. 
  

 
  
  
External Link: 
Here you can define a link to a website (e.g. "www.abacom-online.de"), or to a special file (e.g. a PDF 
document with a datasheet). 
  
Your text-label will be displayed underlined: 
  

 
  
If you make a doubleclick on the underline, the link will be executed.  
Please note, that the displayed text must not be equal with the external link. 
  
  
Internal Link: 
You can create active links from one place on your diagram to another place. It doesn't matter, if the 
link is on the same page or on another page. You can follow the links with a simple mouse click, so you 
are able to create interactive circuit diagrams. 
  
With the option Available as target you can define, if the selected text should be available as a target 
for other links. 
  
If you click on Select target... you can select the target from a list of all available targets. If you 
haven't yet define another text-label as an available target, this list will be empty. 
  
To remove a target, just click on Select target... and select Delete target. 
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All targets will be named with the text of its label. So you have to pay attention to the following 2 
points: 
  

l Take care of the target labels text. Please don't use the same text for more than one target label 
to avoid confusion.  

l If you have to change the text of a target label, please adapt all labels that use this link as a 
target. Otherwise, the target won't be found anymore. 

  
Labels with active links will be displayed like this: 
  

 
  
All labels which are "available as target" get an inner arrow on the left side. 
All labels which are active links (which has a target) get an outer arrow on the right side. 
So you can always see, which labels are active links or targets. 
  
Follow an active link 
If you move the mouse on an active link, the target of this link will be shown. 
You can follow this link with a doubleclick. 
  
If you make a doubleclick on the right arrow, you will follow the active link. 
If you make a doubleclick on the left (inner) arrow, you will get to the text-label, which has the link as a 
target. 
If you make a doubleclick on the underline, you will call the external link. 
  
  
Creating a link list 
sPlan offers the possibility to create a link list. This list contains all active links together with their text 
lables and pages. To create a link list choose Create link list... of the Function menu. 
  
Parent-Child relations 
  
Components can have a Parent-Child relation. A "parent" knows all his "childs", and a "child" knows his 
"parent". This allows a child to get the identifier and the value of his parent. If the parent is changed, 
the child will change his identifier automatically. This is a big advantage, especially if you are using 
contactors and contacts or IC's with several gates. 
  
Here is an example with a contactor and 3 accessory contacts: 

 
The contactor is a parent and has the identifier K1. 
The contacts are subordinated as childs to the contactor and they adopt the identifier K1 automatically 
from the parent. If the identifier of the parent will change, the identifier of all contacts will change 
automatically. 
The contacts can even be spread over all pages of your project. 
  
Here is an example of a 7400-IC: 
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The main component on the left is the parent and the 4 gates are the childs. 
The 4 childs adopt the identifier IC1 and also the value 7400 of the parent in this example. 
If the identifier or the value of the parent will change, all identifier or values of the childs will change 
automatically. 
The gates can also be spread over all pages of your project. 
  
  
Creating a Parent-Child relation 
The creation of a parent-child relation is very simple: Just click with the right mousebutton on a 
component, and select the command Set parent. Now you can select a parent from the list of available 
parents. If you want to set a parent for more than 1 component, just select the desired components and 
the call the command Set parent. The parent will be set for all selected components. 
  
Example: 
If you have a contactor and 3 contacts (just like in the example above), you select the 3 contacts, click 
with the right mousebutton to one of the contacts and set the parent to the component K1. 
  
  
Parent: 
To get a component into the list of available parents, it must be defined as a parent before. 
To define a component as a parent, just doubleclick the component and activate the option Parent 
(accept childs). Now this component will appear in the list of available parents. 
  
  
Child: 
A component become a child automatically, if a parent will be set. 
The child will get 2 variables in his properties, to get the identifier and the value automatically: 
  
The identifier changes to the variable <PARENT_ID> 
The value changes to the variable <PARENT_VALUE> 
  
These 2 variables are the wildcards for the identifier and the value of assigned parent. 
You may change or extend these settings. Here you get more information about using Variables and 
Text constants. 
  
There are 2 more variables, which you may use: <CHILDNO> and <CHILDCHAR> 
  
The parent conducts all his childs, and gives serial numbers to them. The variable <CHILDNO> is the 
wildcard for this number. If a parent has 3 childs, then these childs have the numbers 1,2 and 3. This 
number may be added to the identifier. If you define the identifier like this: <PARENT_ID>-
<CHILDNO> the identifier will be displayed e.g. like this: 
IC-1, IC-2, IC-3,... 
  
The variable <CHILDCHAR> the wildcard for the alphabetical character of this number (a,b,c,...). 
If you define the identifier like this: <PARENT_ID>-<CHILDCHAR> the identifier will be displayed 
e.g. like this: 
IC-a, IC-b, IC-c,... 
  
  
  
Parent-Childs in the library: 
It is possible to add a complete parent-child structure as 1 component to the library. 
This may be useful for the above example with the 7400-IC and his 4 gates. 
To do this, just select the parent and all his childs on your plan. Now click with the right mousebutton 
on the parent and select the command Add component(s) to library. Only the parent component will 
be added to the library, but the childs will be also in the library. You can detect a little triangle in the 
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library component of the parent. If you move the mouse over this triangle, the childs that are assigned 
to this parent will be displayed: 
  

 
  
If you drag a parent component to your plan, the parent and all his childs will be added to your plan. 
  
  
Display colored Parent-Childs 
sPlan is able to display all parent-child components in different colors on the plan. So you can see all 
components which are defined as parents or as childs at a glance. 
  

 With this button in the toolbar you can activate or deactivate this function. 
  
All parents will be displayed in a light blue, and all childs will be displayed in a light red. 
If you select a parent or a child, the parent and all his childs will be colored stronger, and you can see 
the unity of the components. 
  

 
  
  
Parent-Child List: 
You can create a hierarchy list of all parents and their childs. 
This list contains all parents and their accessory childs over all pages in your project. 
To create this list select the menu-item Create parent-Child list... from the Functions menu. 
  
Component search 
  
sPlan offers a special search function for components. This function is useful with large projects that are 
spread to several pages. Components can be searched, using their identifiers and values. The function 
can be called with Search components... from the Edit menu or from the corresponding button in the 
toolbar. 
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Identifier 
A filter can be set to find components with certain identifiers: 

l Leave this field empty to list all components.  
l Type e.g. "R" to find all components with a "R" in its identifier (R1, R8, R12, etc.)  
l The filter "R1" will find all components with R1 in the identifier (R1, R11, R12, etc.)  

  
Type / Value 
A filter can be set to find components of certain types or with certain values: 

l Leave this field empty to list all components.  
l With this filter set to "6" all components with a "6" in the type/value field will be listed (0,68µF, 

16k, etc.).  
l With this filter set to "0,68" all components with a "0,68" in the type/value field will be listed 

(0,68µF, etc.)  

  
Both filters can be combined. 
  
All pages 
Select this option to search components on all pages. Otherwise components are searched on the 
current page only. 
  
Start search 
This will start the searching progress. The list will be filled with all components that match with the 
filters. 
  
You can double click to the identifier field of the list, to select and show the component in the diagram. 
  
Tip: 
The type/value field of the list is editable. This is an efficient way to enter values for your components. 
Printing 
  
sPlan is equipped with a comfortable preview for printouts. So you can always see what effect an option 
will have, before you waste any paper. You can select the printer, adjust the scale and the position of 
the printout, and so on. 
  
Select Print... from the File menu, or press the corresponding button in the toolbar to open the preview 
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window.  
  

 
  
The preview will be more precise, if you maximize the preview window. 
  
On the left of the preview window you find the print options. The white area on the right represents the 
paper sheet and the red frame indicates the printable range of your printer. A page can be selected on 
the bottom of the preview. The printer name is displayed in the headline. 
  
Changing the position of the printout 
The position of the printout is adjustable directly in the preview. You can move the diagram to the 
required position on the white paper. Click to the diagram in the preview and move it to the wanted 
position, while holding down the mouse button. 
  
Scaling 
Select the option "1:1" if no scaling is required. 
Select "User" to change the scaling with the slider. 
  
Caution: Mostly printers can not print exactly to the edges of the paper. If your diagram uses the full 
paper format you will have to choose a scaling of about 95% to avoid clipping printouts. 
  
Select paper orientation 
The printer should use the same orientation as the page format, that you have entered for the page. 
Otherwise you will asked to change the printers paper orientation. 
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Banner printing 
This new function lets you print your drawing spread over several pages. So you can e.g. create a A2 
printout with a normal A4-printer.  
You can define how many pages you want to use in X- or Y-direction. You can also define the Overlap 
of the pages in mm. Now you can scale and move the printout so that is fits over all pages. 
  
Pagesize 
Select this option to display the size of the page as a light grey background. The page size is only visible 
in the preview. This option has no effect on the printout. 
  
Printing selection 
Here you can select if you want to printout only the current page, all pages or a selection of pages. If 
marked selection, you can click on the "..." button to select several pages of your project. 
  
Fit to page 
Click this button to fit your diagram to the paper automatically. 
  
Center 
Click this button to adjust the diagram in the center of the paper. 
  
Apply 
If you press this button, all current settings like scaling, orientation or the position will be applied to all 
other pages of your project. 
  
Setup 
This button calls the setup dialog for the available printers. Here you can choose a printer, and you can 
call the setup dialog for the selected printer. 
  
Print 
This button starts the printout. 
  
Close 
Use this button to close the print preview without printing. 
Exporting circuit diagrams 
  
If you wish to use a circuit diagram with other applications, you can export it to a common format. You 
can choose between 4 file formats: 
  

l GIF  
l JPG  
l BMP  
l EMF  
l SVG  

  
GIF, JPG and BMP are files in pixel format.  
sPlan is working with vector graphic. The conversion of a vector graphic to a bitmap graphic is always 
lossy. To keep the loss small, you can choose a high resolution. 
  
GIF and JPG are compressed files, which keeps the file size small 
BMP is a uncompressed file format and produces large file sizes. 
We recommend using the GIF or the JPG format. 
  
The EMF-format is a vector format and so it produces high quality exports. But unfortunately this format 
causes problems in many applications. You can export this format and try to import it in your 
application. If you have any problems with this format within your application, you should not use it 
anymore. Please select another export format like JPG to use it with your application. 
  
The SVG-format is also a vector format. SVG means Scaleable Vector Graphics. SVG-files are accepted 
by many browsers like Firefox, etc. and other applications. We recommended to use this format instead 
of the EMF-format id a vector-format is required. 
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The Export function is available from the File menu. 
  

 
  
Filetype 
You can choose either GIF,JPG, BMP,EMF or SVG for the export format.  
  
Size (only GIF, JPG and BMP) 
Use the slider to adjust the bitmaps resolution. Keep in mind that high resolutions (high quality) need 
more memory resources, than lower values. The necessary memory is being displayed (only BMP). Try 
to reduce resolution as much as you can, with acceptable quality. This is most important with colored 
bitmaps. 
  
Color (only BMP) 
Whenever possible you should select B&W, to reduce the bitmaps size. Only select COLORED if you 
really use colored objects in your diagram. A monochrome bitmap that uses 500 Kbytes needs about 12 
Mbytes if exported in colored mode with the same resolution! This may take some time. 
You can use B&W even if the diagram contains colored object, to save resources. 
You can monitor the required memory, when you make changes to color or resolution. 
  
Selection 
Here you can define if you want to export the whole page size, all elements or only the selected 
elements. 
  
Keyboard controls 
  
You can control many functions of sPlan with your keyboard. 
  
Often needed functions like copy, paste, delete, duplicate, etc. can be called with special hotkeys. These 
hotkeys were displayed in the main menu right beneath the entry. 
  
Additional functions are available: 
  
Moving elements with the cursor keys 
Selected elements can be moved with the cursor keys. They will move always one grid. If you press the 
SHIFT-key simultaneously, you can move the elements in 1/10 mm steps. 
  
Selecting elements with the TAB-key 
You can select elements one after another with the TAB-key. Every time you press the TAB-key the next 
element will be selected. If you press the SHIFT-key simultaneously, the last element will be selected 
instead of the next. 
  
Calling the property dialog with ALT-Return 
You can call the property dialog of a selected element by pressing ALT-Return. This will only work if 
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exact 1 element is selected. 
  
Zoom with the keyboard 
F5 zooms to the whole page 
F6 zooms to all elements on your diagram 
F7 zooms to all selected elements on your diagram 
+ zoom in 
- zoom out 
  
Follow an active link 
With F8 you can follow an active link. The active link has to be selected for this. 
  
  
Software registration 
  
You can send us your registration form, to get information about updates and new ABACOM products. 
  
Note: 
If you received your software directly from ABACOM, a registration is not necessary. 
Tips and hints 
  

l You can always go back to the standard (arrow) mode, with the right mouse button (except the 
zoom mode) 

l You can always disable the grid capture temporary with the CTRL-key. So you don't have to switch 
the grid on or off. 

l You can always disable the angle capture while drawing lines or rotating elements temporary with 
the SHIFT-key. 

l If you click on a selected element again, the sizer will change into arrows. Now you can rotate or 
shear the element with your mouse. 

l If you have selected a line or a polygon, you can move single line-segments of the line or the 
polygon, while you keep the ALT-key pressed. 

l If you press the SHIFT-key while rotating or mirroring, the text won't be rotated or mirrored. You 
may have to align the text new, but therefore the text is always readable. 

l You can change the text positions of the identifier, value or contacts of a component directly in 
your diagram. Just click on the text element and move it (the component should not being 
selected before). There is no need to call he component editor for this. 

l You can zoom with your mouse wheel, if you keep the CTRL-key pressed. 
l If you want to create a circle with a dashed line, you can create with the special form function a 

regular polygon with enough edges (e.g. 32 ore more) as a line. After that, you can doubleclick on 
the "circle" and define a line style. 

l You can easily sort your components in the library per drag&drop. Just click on a component in the 
library and move it to the new place in the library. 

l You can adjust the width of the library with the mouse. 
l You can add your own form sheets to your circuit diagram 
l You can simply draw magnetic lines out of the rulers. To delete magnetic lines, just draw them 

back to the ruler. 
l If you want to publish your circuit diagrams in the internet, you should export the diagram with a 

high resolution. After that you can shrink the picture with a graphic application. This will result in 
a very good quality, because most graphic applications use anti-aliasing to shrink pictures. 
As an alternative way, you can offer your *.SPL files for download, and refer your visitors to the 
free viewer application for sPlan. 

The Viewer 
  
The Viewer is used to open, view and print sPlan files.  
  
The viewer contains only of one single EXE-file: SPLAN70_VIEWER.EXE 
  
The Viewer is freeware, so everyone can view and print sPlan schematics. 
  
After the installation of sPlan, the Viewer can be found in the installation directory of your sPlan 
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software. 
The viewer is also available as a free download from our homepage. 
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